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Nothing is simpler to use than the ACR SmartButton. It is 
a powerful, versatile, and easy to use data recorder that 
enables logged data to be collected and thoroughly 
analyzed in seconds. 
 
Using this product is a snap! Use built-in menus for 
Sample Rate, Start Delay, Alarm setups and more. Then, 
logged data can be viewed in Table or Graphical format, 
permitting detailed analysis of logged data. 
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1. History of ACR SmartButton Reader 
SmartButton for Windows V1.11 October 11 2002 

 
Version 1.11 Modifications And Fixes: 

 
 1. Fix the bug where the .smt was not registered in the system. 
 2. Fix the bug where canceling the file-open form causes the application to crash. 
 3. Localization for language functionality is added. Resources for Localization are separate from executable and 

can be installed afterward. 
 4. Spanish language resource is added, the application will run a Spanish version if the window system is set to 

Spanish.    
 
 
SmartButton for Windows V1.10 January, 2002 
 
Version 1.10 Modifications And Fixes: 

 
1)   The SmartButton specifications, pertaining to operating conditions, have been changed.  
      The previous operating conditions were noted as -20ºC to +85ºC. The new operating  
      conditions are -10ºC to +85ºC. 
 
2)   The use of an animation in the "About Window" splash screen has been added. 
 
3)   The SmartButton Reader installation set up layout has been changed to include the 
      "click and accept" software license agreement.  
 
4)   The total time of alarms, located in the SmartButton Status Window box, did not display  
      properly and has been corrected. 
 
5)   The capacity field for the SmartButton memory capability, located in the SmartButton Status  
      Window box, has been removed. 
 
6)   The desktop shortcut "Contact" ICON has been modified in its appearance.  
 
7)   In previously selecting the "Contact" button with frequency, it caused the button to freeze.  
     This has been addressed and resolved. 

 
8)   Comments, when printed on select printers, would not transfer correctly to the printed  
      document. The font and size have been altered to eradicate the problem. 
 
9)   When installing ACR SmartButton Reader software, a new folder group called "ACR Data Logger  
      Software" is created and relevant shortcuts will be installed in this folder.  
 
10)  The time and temperature line that was resident inside the graph window, corresponding to  
       the mouse movement, was removed. 
 
11)  A Print dialog box has been added for when print menu item is selected. 
 
12)  The "ACR Website link" icon was added to the application's toolbar. If the computer being  
       used has Internet access, this icon will provide a shortcut to the ACR corporate website. 
 
13)  The "Help" ICON has been added to the application's toolbar. This provides a direct link to  
       the application's Help Files. 
 
14)  The Graph Name field, located in the Status window, has been changed from its original  
       purpose of naming the graph during download. It is now called "Logger Name" and allows  
       for a 32-character name to be entered and stored inside the ACR SmartButton. The default  
       logger name will remain the ACR SmartButton serial number.  



ACR SmartButton Reader User Manual   
 

 
ACR SmartButton Reader V1.11  Page 6 

 
15)  Alarm line indicators have been added to the graph display to highlight the areas in which 
       the data has exceeded the programmed alarm. 
 
16)  The advanced tab has been removed. 
 
17)  The Data Table function that highlights current data displayed in the graph window, has  
       been changed to a blue from the previous yellow. 

 
18)  The advanced features of the Help File picture inserts, have resulted in a upgraded minimum  
       hardware requirements list. The new requirement is the capability to display a 16 bit true  
       color (graphics card may be necessary). 
 
19)  The SmartButton data files default storage area was previously within the program file  
       folder. This new release creates a file folder in the 'My Documents' folder called  
       'ACR SmartButton Files'. 
 
20)  Direct links to relevant Help Files have been created within the ACR SmartButton Reader  
       program using the 'F1' Microsoft Windows methodology. 
 
21)  The date/time selection for the start delay has been enhanced to include a calendar pop  
       up menu 
 
22)  Under the Alarm Tab heading, the columns listed have been changed to "Start Time" and  
       "End Time" with a total accumulation of alarms in minutes. Previously, alarms were calculated  
       to a maximum event time of 255 minutes.   

 
23)  TrendReader files converted from SMT files can be opened by TrendReader without need of  
       custom equation 101. 
 

Still Remaining as Unresolved: 
 
1)    Sluggish nature of zooming function. 

 
Version 1.01 Modifications and Fixes:  

 
1)   The problem where printing in landscape was not possible in Windows NT and Windows 2000 

has been eradicated. 
 

Version 1.00:  **Initial release**. 
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2. Topics To Be Covered 
 

SmartButton Reader is a powerful and easy to use program designed and developed by ACR Systems Inc.  In 
order to get you started in the right direction, we recommend that you cover every topic within this manual. 
However, each area is inclusive, in that you will be able to perform the task without needing a prerequisite. 
 
ACR SmartButton Reader Overview 
ACR SmartButton Reader: Learn about the specifications, operation and warranty information of your software.  
 
Using SmartButton Reader Software 
 
Getting Started: Learn the basics about what you need and how to connect to your PC. 
Configuring The Hardware: Learn how to get your computer hardware configured with the SmartButton solution. 
Contacting A SmartButton: Talking to the ACR SmartButton. 
Status Window Overview: Familiarize yourself with the features in the Status Window. 
 
Setting up a SmartButton 
Setting Up A NEW SmartButton: First time operation of your SmartButton Data Logger. 
Setting Up A SmartButton: Quickly learn the setup procedure for your ACR SmartButton data logger. 
Backup A SmartButton: Learn to save and view the information in your ACR SmartButton data logger. 
 
Working with the Data 
Tab Functions: Learn the options available under the tabs; summarize your data, create a spread sheet table or 
detail alarms.  
Desktop Tab And Graph Options: Print, zoom, change your settings and learn other features available within the 
customizing features.  
 
SmartButton Reader Menu Options 
File Menu: Learn the options available under this Menu.  
Communicate Menu: Learn the options available under this Menu.  
Graph Menu: Learn the options available under this Menu.  
Options Menu: Learn the options available under this Menu.  
Window Menu: Learn the options available under this Menu.  
Help Menu: Learn the options available under this Menu.  
 
Graphing Options  
Zooming Graph: Learn to view the areas of your graph that you are most interested in. 
Graph Settings: Change the look and feel of your graph appearance. 
Printing Graph: Select the print options that best suit your presentation needs. 
Saving Graph As A Comma Delimited(CSV) Data File: Learn to transfer your data into a spreadsheet program. 
 
Still Having Trouble  
Frequently Asked Questions: Some of the most common questions that users have about data loggers. 
Troubleshooting Help: Some of the most common issues when using your ACR product. 
 
Technical Support:    
Technical Support: Contact information for any difficulties that cannot be resolved with this information.  
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3. Quick Start Manual  
 

Welcome to the Quick Start Section. As previously mentioned, we encourage you to read through the full 
manual to learn all of the features and functions of this product. This section provides you with enough 
information to enable you to get started, right away! 
 
Contacting: 
To download data from the ACR SmartButton, insert it into the ACR SmartButton interface cable. Ensure that 
the cable is securely fastened to the computer port and click the Contact icon on the toolbar. After contact with 
the ACR SmartButton is established, the application displays the ACR SmartButton Status window. The ACR 
SmartButton Status window: displays the current operational parameters of the ACR SmartButton; its serial 
number, sample interval, data stored, alarm thresholds, etc. 
 
Backup: 
To download data from the ACR SmartButton to the computer, click the Backup icon in the Status window. In 
the Save As window, enter the file name and the location to store the data. After specifying a filename and 
location, click OK to start the backup. The application copies the data from the ACR SmartButton to the file and 
automatically graphs the data after the backup completes. 
 
Setup: 
Select the desired sample interval, start delay, temperature thresholds and logger name for the ACR 
SmartButton and click SETUP. The application uses the settings displayed in the Status window to configure 
the ACR SmartButton. 
NOTE** Clicking the SETUP button deletes all stored data in the ACR SmartButton. 
 
Clear: 
Click the CLEAR button to delete all stored data in the ACR SmartButton. The current operating conditions 
programmed into the button will remain. 
NOTE** Clicking the CLEAR button deletes all stored data in the ACR SmartButton. 
 
Data Display: 
After the application copies the data from the ACR SmartButton to the computer, it displays a graph of that data. 
The top portion of the window displays the data in a graph format. The bottom of the window contains three tabs 
that offer different summaries of the data set: data statistics, a tabled listing of all of the data and a table of 
alarm information. 
 
Zoom/ Unzoom: 
Reduce or magnify any area of the data set by zooming a particular region. To define a zoom region, position 
the mouse at one end of the desired region, then click and hold the mouse button. Drag the mouse to the left, or 
right, to define the end of the zoom region. Release the mouse button when finished. The application redisplays 
the data inside the zoomed region. To display the previous data set region, select the Unzoom item found in the 
Graph menu. If you have zoomed several times and wish to return to the original data set, select the Unzoom 
All item, also found in the Graph menu. 
 
Print: 
To print data to paper, click the Print icon from the toolbar or select the Print item under the File menu. The 
application will print the displayed data set to the specified printer. To learn about changing printers or printing 
options please visit the Printing A Graph Section. To print a table format of your data (instead of the standard 
graphing format), you must transfer your data into a spreadsheet program and print from that program. To learn 
more about this process, please visit the Saving A Graph As A Comma Delimited (CSV) Data File section. 
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4. ACR SmartButton Reader Overview 
 
 

 
 

Thank you for choosing the ACR SmartButton Reader for your data logging requirements. This logger is the 
ideal choice for easy data collection within merciless environments.  
 
This information has been designed to get you working as quickly and easily as possible with your new data 
logger. It will explain the operation of downloading, displaying and working with the data contained in the 
SmartButton data logger. Additionally, it has been layed out in a progressive manner, whereby you may follow it 
page by page to learn step by step, how to use your data logger. 
 
The SmartButton is a single channel, extremely robust data logger. Its durable construction makes it the ideal 
product for unforgiving environments. Water, dirt, corrosive mediums are no match for the design of this 
product.  
 
With this logger you can define your recording interval, choose to delay your start time, whereby making the 
functionality for your specific application customizable. 
 
The SmartButton is designed to work simply and effectively with the SmartButton Reader software. The 
program comes complete with built-in menus for customizing your SmartButton right away. Simply determine 
your operating parameters and you are ready to go into the field and perform your test. 

 
 

4.1. Hardware Warranty 
 

Please note the following disclaimer when using ACR products: 
 
ACR Systems Inc. ("ACR") warrants that its data loggers will perform substantially in accordance with the 
product documentation supplied with the data loggers (the "documentation") for a period of three years 
from the date of shipment from ACR.  If you have acquired the data logger from an authorized ACR 
reseller, we will delay the commencement of the warranty until the date the data logger was shipped to 
you by the reseller, provided that within 90 days of the data logger being shipped to you by reseller, you 
or the reseller provide us with the serial number of the data logger, your name, and the date the data 



ACR SmartButton Reader User Manual   
 

 
ACR SmartButton Reader V1.11  Page 13 

logger was shipped to you.  During the warranty period, ACR shall repair or replace, at its option and at 
no additional charge to you, any data logger that fails to perform substantially in accordance with its 
documentation (a "defective data logger").  If you wish ACR to repair the logger, you must contact ACR, 
obtain a return merchandise authorization ("RMA") number and ship the defective data logger to the 
designated ACR facility.  ACR will not accept any product returned without an RMA number.  You shall 
bear all costs of delivering the defective data logger to the ACR facility and ACR shall bear all costs of 
delivering the repaired or replacement data logger back to you.  Replacement data loggers shall be 
covered by this warranty only for the remainder of the warranty period for the replaced data logger.  In no 
event shall ACR be responsible for the repair or replacement of any data logger if ACR reasonably 
determines that a problem results from: 
 
a.  The use of the data logger in a manner or for an activity not contemplated by the documentation. 
b.  The use of the data logger in conjunction with software or hardware that has not been supplied or 

specifically authorized by ACR. 
c.  Abnormal environmental conditions. 
d.  Wiring, electrical or network problems. 
e.  Your willful or negligent acts. 
 
To the maximum extent permitted by applicable laws, ACR disclaims all representations, warranties, and 
conditions not expressly provided herein, whether expressed or implied, Including without limitation any 
implied warranty or condition of fitness for a particular purpose, merchantability, durability, performance 
and non- infringement.  In no event shall ACR Systems Inc. or its suppliers or resellers be liable for any 
indirect, consequential, incidental, special or punitive damages arising out of the use of a data logger and 
ACR's aggregate liability to you shall not in any event exceed the amount paid to ACR for the data logger 
associated with such liability.  The exclusions and limitations set out herein shall apply regardless of 
whether the liability arises out of breach of contract, tort or statutory liability.  This warranty sets out your 
sole remedies in connection with or arising out of your purchase of a data logger. 

 
 

4.2. Software Notice 
 
IMPORTANT NOTICE:  

  
CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS.  IF YOU ARE PREPARED TO ACCEPT THESE TERMS AND CONDITIONS 
PLEASE INDICATE THIS BY CLICKING THE “I ACCEPT” BUTTON PROVIDED BELOW.  YOU WILL NOT BE ABLE TO COMPLETE 
THE INSTALLATION OR USE THE ACR SOFTWARE SUPPLIED IN ASSOCIATION WITH THESE TERMS AND CONDITIONS AND ANY THIRD 
PARTY SOFTWARE EMBEDDED IN THAT SOFTWARE (COLLECTIVELY THE “SOFTWARE”) UNLESS YOU ACCEPT THESE TERMS AND 
CONDITIONS.  PLEASE FEEL FREE TO CONTACT ACR IF YOU HAVE ANY QUESTIONS OR CONCERNS ABOUT THESE TERMS AND 
CONDITIONS.  IF, PRIOR TO COMPLETING INSTALLATION OF THE SOFTWARE, YOU DECIDE YOU ARE UNWILLING 
TO ACCEPT THESE TERMS AND CONDITIONS, INDICATE YOUR DECISION BY CLICKING ON THE “I DO NOT ACCEPT” BUTTON.  
THE INSTALLATION OF THE SOFTWARE WILL CEASE, YOU MAY RETURN THE SOFTWARE AND ANY ACR DATA LOGGER YOU 
PURCHASED IN CONJUNCTION WITH THE SOFTWARE AND YOU WILL BE RELIEVED OF ANY OBLIGATION TO PAY FOR THE SOFTWARE 
AND THESE ACR DATA LOGGERS.  IF YOU HAVE ALREADY PAID FOR THE SOFTWARE, THE SOFTWARE MEDIA OR   THE ACR 
DATA LOGGERS, IF APPLICABLE, ACR OR ACR’S RESELLER (DEPENDING ON WHO SUPPLIED THE EXECUTABLE COPY OF THE  
SOFTWARE TO YOU) WILL REFUND THESE MONIES TO YOU UPON RETURN OF THE SOFTWARE, THE ACR DATA LOGGERS, AND ALL 
ACCOMPANYING ACR DOCUMENTATION (THE “DOCUMENTATION”) AND PROOF OF PURCHASE.  ACR CAN BE REACHED AT: 

ACR Systems Inc., 
Address: # 210-12960 84th Ave., Surrey B.C., Canada, V3W 1K7 

Phone: 1-800-663-7845 (toll free) or 1-604-591-1128 
Fax: 1-604-591-2252 

E-mail: enquiry@acrsystems.com 
Website: www.acrsystems.com 

 
SOFTWARE LICENSE AGREEMENT 

1. LEGAL AGREEMENT.  THIS IS A LEGAL AGREEMENT BETWEEN YOU AND ACR SYSTEMS INC. (“ACR”).  Please 
treat it as valuable property. 

2. OWNERSHIP OF SOFTWARE.  The Software and Documentation is licensed and not sold to 
you.  Although you own any media on which the Software is supplied, this Agreement 
does not convey to you any ownership right, interest or title in or to the Software, 
or to any related intellectual property rights.  

3. GRANT OF license(S).  Subject to the terms and conditions set out in this Agreement 
and of your paying any necessary fees for the Software or the Software media, ACR 

mailto:enquiry@acrsystems.com
http://www.acrsystems.com/
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hereby grants to you, for each item of Software provided to you, a personal, non-
exclusive and non-transferable license to make the number of copies of the Software 
for which you have paid the applicable fees, and to install and to use the object 
code for each authorized copy of the Software on no more than one personal computer 
at any given time, and to use the documentation supplied with the Software (the 
“Documentation”) solely in connection with this use. If you have paid an authorized 
ACR Reseller (“Reseller”) for the Software media, ACR shall grant you the license 
contemplated in this paragraph at no additional cost. 

4. RESTRICTIONS.  You shall not (i) use the Software except as expressly permitted in 
this Agreement and for the purposes contemplated by the Documentation, (ii) 
redistribute or authorize or acquiesce in the use of the Software by any third party 
(other than consultants who need to use the Software in order to perform services on 
your behalf), or (iii) attempt to defeat any protection method designed to prevent 
the unauthorized use of the Software.  You shall not copy or reproduce the Software 
except as expressly authorized in paragraph 3 and except to make one archival copy 
to be stored in a secure location and used for back-up purposes only.  For the 
purposes of this provision, “copy” shall not include copying that naturally results 
from the authorized use of the Software or in the course of making regular back-ups 
of the computer or system on which the Software is installed.  Upon request by ACR, 
you agree to give ACR access to your site during regular business hours solely for 
the purpose of ensuring compliance with the terms of this license. 

5. CONFIDENTIALITY.  The Software and Documentation contains information that is 
confidential and proprietary to ACR.  Upon receipt of your written request, ACR 
shall provide you with any information about the Software in its possession or 
control that you require to operate the Software in conjunction with any other 
software or equipment that you use in your business.  You shall not: remove any 
notices, labels or marks from the Software; deliver, disclose, convey, either 
directly or indirectly, the contents of the Software to any third party; or alter, 
modify, translate, decompile, disassemble, or reverse engineer the whole or any part 
of the Software, without first obtaining the express written consent of ACR. 

6. ONE YEAR Warranty.  ACR warrants that it shall use reasonable commercial efforts to 
resolve any problem with the Software of which you notify ACR during the warranty 
period that precludes the Software from operating substantially in accordance with 
its Documentation.  The warranty period for the Software is one year from date of 
shipment (or downloading from ACR or Reseller).  TO OBTAIN WARRANTY SUPPORT FOR THE SOFTWARE, 
YOUR COPY OF THE SOFTWARE MUST BE REGISTERED WITH ACR WITHIN 90 DAYS OF THE DATE OF PURCHASE OF THE 
SOFTWARE MEDIA OR YOU MUST PRESENT A COPY OF THE RECEIPT FOR THE MEDIA AT THE TIME YOU REQUEST SUPPORT.  TO 
REGISTER THE COPY OF THE SOFTWARE LICENSED TO YOU, SEND  ACR BY FAX, EMAIL OR MAIL: YOUR NAME, THE DATE 
ON WHICH THE SOFTWARE WAS SHIPPED TO YOU AND THE SERIAL NUMBER OF THE SOFTWARE. In no event shall ACR 
be responsible for any problem with the Software or damage caused by the Software if 
the problem or damage is due to: (a) a modification of the Software made or required 
by any person other than ACR or its agents; (b) its use in association with other 
software or hardware (other than software or hardware with which the Documentation 
specifically indicates it is compatible); (c) its use in a manner or for an activity 
not contemplated by its Documentation; (d) electrical supply, wiring or network 
problems; (e) the improper installation of the Software; (f) abnormal environmental 
conditions; (g) a failure to install any bug fix supplied by ACR; or (h) the wilful 
or negligent acts of any person other than ACR or its agents.  If ACR is unable to 
resolve any problem contemplated by this warranty provision, ACR, or the Reseller, as 
the case may be, shall refund to you the monies you paid to it to acquire the 
Software and the Software media.  If there is a defect in the media on which the 
Software was supplied you may contact ACR during the warranty period, obtain a Return 
Merchandise Authorization (“RMA”) and upon receipt of the defective media, the 
dated proof of purchase and the RMA, ACR shall replace the defective media at no 
charge.  This paragraph sets out your sole remedy for the breach of the warranty set 
out herein. 

7. NO Additional WARRANTIES: TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW THE WARRANTY SET OUT IN 
PARAGRAPH 6 IS THE ONLY WARRANTY, MADE WITH RESPECT TO THE SOFTWARE, AND NO OTHER WARRANTY, REPRESENTATION 
OR CONDITION EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTY  OR CONDITION OF 
MERCHANTABILITY, NON-INFRINGEMENT, PERFORMANCE, DURABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR USE SHALL 
APPLY.  ACR does not warrant that the Software will operate on a continuous and 
trouble free basis.  You are responsible for selecting the software that will achieve 
your desired results, and for the installation, use and results obtained from the 
Software. 

8. LIMITATION ON LIABILITY  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL THE 
AGGREGATE LIABILITY OF ACR, ITS SUPPLIERS AND RESELLER TO YOU EXCEED THE AMOUNT YOU HAVE PAID TO ACQUIRE 
THE SOFTWARE AND SOFTWARE MEDIA, AND IN NO EVENT SHALL ACR, ITS SUPPLIERS, OR RESELLER BE LIABLE FOR ANY 
INDIRECT, INCIDENTAL, CONSEQUENTIAL, OR SPECIAL DAMAGES, INCLUDING WITHOUT LIMITATION ANY DAMAGES FOR LOST 
PROFITS OR SAVINGS, REGARDLESS OF WHETHER THEY HAVE  BEEN ADVISED OF THE POSSIBILITY OF SUCH damage.  
EXCEPT TO THE EXTENT THAT THE LAWS OF A COMPETENT JURISDICTION REQUIRES LIABILITIES BEYOND AND DESPITE THESE 
LIMITATIONS, EXCLUSIONS AND DISCLAIMERS, THESE LIMITATIONS, EXCLUSIONS AND DISCLAIMERS SHALL APPLY WHETHER 
AN ACTION, CLAIM OR DEMAND ARISES FROM A BREACH OF WARRANTY OR CONDITION, BREACH OF CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR ANY OTHER KIND OF CIVIL OR STATUTORY LIABILITY CONNECTED WITH OR ARISING FROM THIS 
AGREEMENT. 
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9. Termination FOR BREACH OF AGREEMENT: The Software is protected by copyright laws and 
International treaty provisions.  There are severe penalties, both civil and 
criminal, for copyright infringement.  Any breach of this Agreement could cause ACR 
irreparable harm.  If you fail to comply with any of the terms of this Agreement, all 
licenses granted hereunder shall automatically terminate without notice, and ACR may 
exercise any or all of its rights under this Agreement or under applicable law, 
including without limitation, obtaining relief by way of a temporary or permanent 
injunction. Upon termination of this Agreement, and in any event upon ACR delivering 
you notice of termination for breach, you shall immediately purge all Software from 
your computer system(s), and return all copies of the Software and Documentation in 
your possession or control to ACR.   

10. PERSONAL Information: You hereby consent to your contact information and 
information about the specific ACR products you have purchased being disclosed to, 
maintained and used by ACR, its affiliates and Resellers solely for the purposes of 
(a) managing and developing their businesses and operations; (b) making information 
about ACR products available to you; and (c) developing new and enhancing existing 
ACR products.  You further agree that we may provide this information to other 
persons as required to satisfy any legal requirements and to any person that 
purchases all or a substantial portion of ACR’s assets provided that they agree to 
use this information only for purposes for which you have provided your consent.  If 
you wish to gain access to any personally identifiable information you have provided 
to ACR or to make any changes to that information please contact ACR directly. 

11. MISCELLANEOUS: Paragraphs 4, 5, 7, 8, 9, and 11 shall survive termination or 
expiration of the license(s) granted hereunder.  When used in this Agreement, the 
term “license” shall be deemed to include “sublicense” for items of third party 
software embedded in the Software.  This Agreement constitutes the entire agreement 
of the parties with respect to the Software, and supercedes all prior communications, 
agreements and discussions between the parties.  It will be governed by the laws of 
the Province of British Columbia, and the laws of Canada applicable therein, 
excluding any rules of private international law that lead to the application of the 
laws of any other jurisdiction.  The United Nations Convention on Contracts for the 
International Sale of Goods (1980) does not apply. The courts of the Province of 
British Columbia shall have non-exclusive jurisdiction to hear any matter arising in 
connection with this Agreement.  If any provision of this Agreement is void or is 
declared void, the provision shall be severed from this Agreement, which shall 
otherwise remain in full force and effect.  
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4.3. About ACR Systems Inc. 
 

 
 

ACR Systems offers a complete line of compact Data Loggers to measure and record temperature, 
relative humidity, electric current, pressure, process signals, pulse frequency, power quality and more.  
ACR Data Loggers have flown with airline pilots, raced with Indy drivers, driven with truckers and have 
even been into outer space. ACR Loggers sit on top, under and in buildings; they operate in tropical and 
sub-zero temperatures, in and out of water and in just about any place imaginable.  
 
ACR Systems continues to be customer-driven, using its research and development expertise to accept 
challenges others prefer to avoid. As a result, ACR remains on the leading edge of technological 
advancements with simple, cost efficient and state-of-the-art, technology-based products. Each ACR 
product will further the tradition of maximizing safety, increasing efficiency and solving problems overdue 
for solution. ACR products continue to be refined and improved to provide customers of every size and 
need with innovative ways to do the job better, faster and more efficiently. 

 
Our contact information:  
Voice: 604.591.1128 
Fax:    604.591.2252 
E-mail: enquiry@acrsystems.com 
Web address: www.acrsystems.com 
ACR  Systems  Inc. 
Unit 210, 12960-84th Avenue 
Surrey, BC  V3W 1K7 Canada 
 
Our customer support representatives are available during normal business hours, 6:30am - 4:30pm 
Pacific Standard Time. 

 

4.4. ACR And The World Wide Web 
 
Your software is equipped with a direct link to the ACR Web Site. Visit the ACR Web Page using your 
installed links in the ACR default file folder or simply click the ACR Web ICON located on your ACR 
SmartButton ICON shortcut bar. 

 

 
 

mailto:enquiry@acrsystems.com
http://www.acrsystems.com/
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Here is an example of the ACR Systems Web Site: 
  

 
 
From here, it's easy to search products, learn what's new, order a catalog, or even see when our 
tradeshows will take us to your area. 
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5. Getting Started 
 

 
Getting started is easy to do with your SmartButton data logger. In this section, we are going to go over the 
components that you need and how they interact with your PC. So, read ahead and follow the steps carefully to 
give you a clear understanding of the physical set-up of the hardware. 
 
In no time at all, you'll be using your data logger and software to it's full capabilities! 
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5.1. Minimum Computer Operating Conditions 
 
 

 
 

The minimum PC hardware operating conditions for using the ACR SmartButton Reader program are: 
• IBM PC or 100% Compatible 
• Pentium 75 (120 recommended) 
• One free serial port 
• 16 MB of RAM (32 MB recommended) 
• Color Monitor 
• Pointing device 

 
The minimum PC software requirements for using the ACR SmartButton Reader program are: 

• Windows 95 
• Windows 98  
• Windows NT with Service Pack 3 or above  
• Windows ME  
• Windows 2000 
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5.1.1. What Do I Need To Get Started? 
 

After you have confirmed that your computer meets the requirements of the Minimum Computer 
Operating Conditions, you will need to make sure that you have the necessary hardware too. In 
order to use the SmartButton Reader software, you will need the following hardware components: 
 
• ACR SmartButton Interface Cable (catalog number 01-0053) 
• ACR SmartButton Data Logger (catalog number 01-0052) 
• ACR SmartButton Reader Software CD (catalog number 34-0010) 
 
In addition to the above noted necessities for operation, please note the hardware options available 
to enhance your operation: 
• Permanent Mount Plate for ACR SmartButton (catalog number 45-0000) 
• Soft Plastic Mounting for ACR SmartButton Ident.(catalog number 45-0001) 
• Angled Hard Plastic Mounting with Security Eyelet (catalog number 45-0002) 
• ACR SmartButton Adhesive (pre-cut to size) (catalog number 45-0003) 

 
As a customer service, we offer the SmartButton product in a starter pack configuration (catalog 
number 01-0055). The package contains two ACR SmartButtons, an ACR Interface Cable, 2 
magnets to affix to the SmartButtons and a software CD Rom. To learn more about this starter 
pack, please look under Upgrading My ACR Product.  
 
After you have finished with this section you may want to visit Preparing your Hardware To 
Use. 
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5.1.2. Preparing Your Hardware To Use  
 

 
At this point, you should know the operating requirements for your computer and the required 
hardware pieces from ACR. 
 
The interface cable is the device that will allow your SmartButton to interact with the computer. It is 
configured with a 9-pin female connector:  

 

  
Look on the back of your computer for the device input with the same number of pins in the male 
configuration and connect the two together. Note** The monitor device input is the same size as 
the 9-pin interface cable, however, it has many more communication pins. After connecting 
the cable to the computer, securely fasten it to the port by tightening the screws on the interface 
cable. 
 
Upon confirming the cable is securely fastened, it's time to place your SmartButton into the receptor 
on the other end of the interface cable. The SmartButton is placed into the receptor with the logo 
facing towards the device (opposite to the picture above). The fit of the SmartButton will be quite 
tight. You can confirm proper placement by feeling a 'click' when the SmartButton has been 
properly fit. 
 
NOTE** IF YOU CANNOT LOCATE THE 9-PIN COMMUNICATIONS PORT, PLEASE REFER TO 
THE Technical Support SECTION. 
 
After you have finished with this section you may want to visit Setting Up A New 
SmartButton. 
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5.1.3. Setting Up A New SmartButton 
 

To access a new SmartButton, insert the SmartButton into the data transfer receptacle and connect 
it to any available port. Select the corresponding port for the software from the Communicate Menu. 
Click on the Contact icon on the toolbar to begin a communications session: 
 

  
 
To set-up, simply change any of the user-changeable parameters in the Status window and then 
click the Setup button. The application will display the SmartButton's Status window once the 
SmartButton is found.  The SmartButton Status window contains three tabs: General, Alarms and 
Advanced. Each tab is described below: 
 
 

General Tab 

 

 
The General Tab displays an overview of the SmartButton's operational parameters.   
The top section:  Logger Information; displays general information about the SmartButton, its 
internal clock, serial number, graph title, sample interval, start time, data capacity and current 
temperature reading. 
The bottom section:  Logger Delay Start Setting; contains the number of minutes the SmartButton 
is to wait before recording temperatures. 
 
Below is a brief description of all user-changeable options: 
Logger Name 
Enter a name of the logger in this variable section. This information is for identifying the ACR 
SmartButton. It will remain stored in the SmartButton's memory after the set-up has been stored.  
The default Logger Name is the serial number of the SmartButton. 
Sample Interval 
Select this option to determine the interval to record data. 
Delay Time 
Enter the delay, in minutes, for the SmartButton to wait before recording data.  The delay can be  0 
minutes to a maximum of 65,535 minutes which is equivalent to 45 days, 12 hours and 15 minutes. 
Enter the delay through a convenient pop-up calendar. 
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Note: The alarm icon appears when the temperature has exceeded the set boundaries. 

 
Alarm Tab 

 

 
The Alarm Tab displays the high and low temperature thresholds.  Once the temperature exceeds 
this range, the SmartButton automatically starts to record data. 

 
The alarm is calculated with a resolution of one minute. If you notice, in the above column noted as 
duration, there are alarms showing 255 minutes. The alarm memory bin can only store up to 255 
consecutive alarms. Therefore, the above 4 lines of alarms are likely to be a consistent alarm that 
has been separated by this capacity limitation. To learn more about setting alarms, visit Setting 
Alarms on a SmartButton. 

 

 
 

At the bottom of the SmartButton status window are four buttons used to control the SmartButton.  
They are: 
Backup 
Click to copy the contents of the SmartButton's memory to the computer to display a graph. 
Setup 
Click to clear all readings stored in the SmartButton as well as change any of the SmartButton's 
configurations.  Specify the desired functionality of the SmartButton using the status window 
options and then click the Setup button to store this information to the ACR SmartButton. 
Clear 
Click to clear all readings stored in the SmartButton's memory.  This button clears only the stored 
temperature readings.  All other operational settings are preserved. 
Close 
Click to close the Setup window. 

 
After you have finished with this section you may want to visit Working With The Data. 
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6. The ACR SmartButton 
 
 

 
Description 

 

The ACR SmartButton is a small, self-sufficient system that measures and records temperature.  Features of 
the  
SmartButton includes: 
 

• Durable stainless steel case to withstand harsh environments. 

• Digital thermometer measures temperature from as low as -10ºC to +85ºC in 0.5ºC increments. 

• Real-time clock accuracy ±2 minutes per month from 0ºC to 45ºC. 

• Automatically measures temperature at user-programmable intervals from 1 to 255 minutes. 

• Logs up to 2048 consecutive temperature measurements in read-only non-volatile memory. 

• Programmable high-temperature and low-temperature alarm trip points. 

• Records time stamp and duration when temperature leaves the range specified by the trip points. 
 

After you have finished with this section you may want to visit Setting Up A SmartButton. 
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6.1. Setting Up A SmartButton 
 

To prepare a SmartButton for use, simply change any of the user-changeable parameters in the Status 
window and then click on the Setup button. 
 

 
See Contacting A SmartButton for more information. 
 
 
 

6.1.1. Contacting A SmartButton 
 

To download data, insert the SmartButton into the data transfer receptacle and connect it to any 
available port.  Select the corresponding port for the software from the Communicate Menu. Click 
on the Contact icon on the toolbar to begin a communications session: 

  
The application displays the SmartButton's Status window once the button is found.  The 
SmartButton status window contains three tabs: General, Alarms and Advanced. For a description 
of the Status Window, please refer to the Status Window Overview section. 

 
 

6.1.2. Status Window Overview 
 

To communicate with the ACR SmartButton, insert the SmartButton into the data transfer 
receptacle and connect it to any available port.  Select the corresponding port for the software from 
the Communicate Menu. Click on the Contact icon on the toolbar to begin a communications 
session: 
 

 
The application displays the SmartButton's status window once the button is found.  The 
SmartButton status window contains three tabs: General, Alarms and Advanced. Each tab is 
described below: 
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General Tab 

 

 
The General Tab displays an overview of the SmartButton's operational parameters.   
The top section:  Logger Information; displays general information about the SmartButton, its 
internal clock, serial number, graph title, sample interval, start time, data capacity and current 
temperature reading. 
 
The bottom section:  Logger Delay Start Setting; contains the number of minutes the SmartButton 
is to wait before recording temperatures. 
 
Below is a brief description of all user-changeable options: 
Logger Name 
Enter a name of the logger in this variable section. This information is for identifying the ACR 
SmartButton. It will remain stored in the SmartButton's memory after the set-up has been stored.  
The default Logger Name is the serial number of the SmartButton. 
Sample Interval 
Select this option to determine the interval to record data. 
Delay Time 
Enter the delay, in minutes, for the SmartButton to wait before recording data.  The delay can be  0 
minutes to a maximum of 65,535 minutes which is equivalent to 45 days, 12 hours and 15 minutes.  
Enter the number directly or select from the drop down list.  
 
Note: The alarm icon appears when the temperature has exceeded the set boundaries. 
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Alarm Tab 

 

 
The Alarm Tab displays the high and low temperature thresholds.  Once the temperature exceeds 
this range, the SmartButton automatically starts to record data. 
 
The alarm is calculated with a resolution of one minute. If you notice, in the above column noted as 
duration, there are alarms showing 255 minutes. The alarm memory bin can only store up to 255 
consecutive alarms. Therefore, the above 4 lines of alarms are likely to be a consistent alarm that 
has been separated by this capacity limitation. 

 
 

 
 
At the bottom of the SmartButton Status window are four buttons used to control the SmartButton.  
They are: 
Backup 
Click to copy the contents of the SmartButton's memory to the computer to display a graph. 
Setup 
Click to clear all readings stored in the SmartButton as well as change any of the SmartButton's 
configurations.  Specify the desired functionality of the SmartButton using the Status window 
options and then click the Setup button to store this information to the ACR SmartButton. 
See also: Setting up a New SmartButton. 
Clear 
Click to clear all readings stored in the SmartButton's memory.  This button clears only the stored 
temperature readings.  All other operational settings are preserved. 
Close 
Click to close the Setup window. 
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6.1.3. Backup A SmartButton 
 
 

Click the Backup button in the Status window to copy the data from the SmartButton to the 
computer.  
 

 
 
Before the data is saved, the application first displays the Save As dialog box: 
 

 
 

 
Enter the desired name of the file to save the data in.  The file name default is the SmartButton's 
serial number.   
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A graph of the data appears once the backup process completes: 
 
 
 

 

 
Once the data displays on the screen, you can Zoom the data graph to see more details, add 
timelines or explore the Statistics Tab, Data Table Tab and Alarm Tab. 
Note: It is necessary to have at least four samplings in order to backup a SmartButton's 
readings. 
 
After you have finished with this section you may want to visit Working With The Data. 
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6.1.4. Setting Alarms On A SmartButton 
 

Alarm Tab 

 
 
 
 

The Alarm Tab displays the high and low temperature thresholds.  Once the temperature exceeds 
this range, the SmartButton automatically starts to record data. 
 
In order to set the alarm function, you need to highlight the alarm that you wish to define (high 
alarm, low alarm, or both): 
 

 
Note** The default in the alarm parameters are the maximum operating conditions of the 
ACR SmartButton.  By changing them, you will automatically trigger the alarm detection 
function. 
 
Once you have sellected the parameters, to save them, you must click the Setup button. By 
selecting the Setup function, you will receive a warning notification. It is notifying you that any 
change to the set-up of a SmartButton will erase all previous information and set-up from the 
previous parameters. 
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When alarms take place they will be noted in the Alarm tab and alarm history portion of the Alarm 
tab within the Status window. In addition to the details noted previously, any alarms will also trigger 
the appearance of a ringing bell upon opening the Status window: 

 

 
 

Alarms are noted on the graph display with a dotted line: 
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7. Working With The Data 
 

 
 

It's time to learn some of the features that are capable within the SmartButton Reader, to tailor your information 
to the needs of your application. In this section you can learn how to change your graph appearance, work with 
the tab functions, zoom in on the data most important to you or even transfer the data into another analysis 
program. 

 

7.1. Tab Functions 
 

The screen for SmartButton Reader is shared between the Graph Area and the Tab Area: 
 

 
To learn the specifics for each area, the Help File has outlined each section individually. Please visit the 
following sections for more information: 
 
•  Statistics Tab 
•  Data Table Tab 
•  Alarm Tab 

 
 

7.1.1. Statistics Tab 
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The Statistics Tab is at the bottom of the graph window and shows the statistical information of the 
graph displayed. 
 

 
 
Note: You may need to maximize your graph window in order to display the Statistics Tab. 

 
 
 

7.1.2. Data Table Tab 
 

The Data Table shows the date, time and the actual reading of the data currently graphed. 
 

 
 
Items in blue are the readings displayed in the graph: 
 

 
 

Note: You may need to maximize your graph window in order to display the Data Table Tab. 
 
To transfer this information to print format, please see the Saving A Graph As A Comma 
Delimited (CSV) Data File section. 

 
 

7.1.3. Alarm Tab 
 

The Alarm Tab is at the bottom of the graph window and displays the alarm thresholds of the 
SmartButton at the time the data was acquired.  
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Note: You may need to maximize your graph window in order to display the Alarm Tab. 
 
To learn about how to set-up alarms, visit Setting Alarms on a SmartButton section. 
 

 
 

7.2. Desktop Tab and Graph Options 
 

The screen for SmartButton Reader is shared between the Graph Area and the Tab Area. Within the 
graphing options area, you can learn to perform the Zooming, Printing and General Settings of the 
graphing functions. These functions can help you make the most of your recorded information. 
 

 
 
Within the graphing options area, you can learn to navigate through the Statistics Tab, Data Table Tab 
and the Alarm Tab. These functions can help decifer your recorded information quickly and easily. 
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7.2.1. Saving A Graph 

 
When saving the information from your data logger into your computer, the ACR standard format for 
the SmartButton is the extention SMT. However, options exist to save the file in different formats. 
After the Save As active form appears: 

 
 

simply choose your required format.The extensions available are: 
 

 
TRW: The default file extension for the premier ACR software known as TrendReader. 
CSV: This is a file that separates each recorded sample by a comma. It is then easily transfered to 
most spreadsheet programs. Lean more by visiting, Saving Graph As A Comma Delimited (CSV) 
Data File. 
 
NOTE** The default storage folder is located in the 'My Documents' folder. 

 
 

7.2.2. Saving A Graph As A Comma Delimited (CSV) Data File 
 

Save data in other file formats for export to other applications, such as Microsoft Excel or ACR 
TrendReader for Windows. To save the data in the .CSV file format, click on the File menu and 
select the Save as option.  The application displays the standard Save As dialog, as illustrated 
below: 
 

 
 
Navigate to the desired location using the standard controls.  Enter the desired file name.  Lastly, 
select the desired file type from the drop-down list.  The available options are: 
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SmartButton Reader (*.smt) 
This is the file format used by the SmartButton Reader application.  Default selection. 
 
TrendReader for Windows (*.trw) 
Use this file type to open the data in ACR's TrendReader for Windows application. 

 
Comma Delimited (*.csv) 
Use this file type to import the graph data into another application, such as Microsoft Excel, for 
additional analysis.  The contents of the resulting file include logger name, serial number, number 
of points, graph title, the time and date of each reading and the data readings.  Data values are 
separated by commas.  This file type's extension is ".CSV" 
 
Click the Save button to save data to disk. 
 
To learn about how to work with the data, visit the Working With The Data section. 
 

 
 

7.2.3. Graph Settings 
 

Use the Graph Settings window to change various display properties.  This feature is found under 
the Graph Tab. 
 

 

 
 

Note the available button commands within the Graph Settings form: 
 
OK: select to finish working with form 
Save As Default: Will apply graph settings to all SmartButton files that have not been altered in 
appearance.  

**Note: If logger file has been modified previously, its settings will override the graph 
default settings.** 

Cancel: to discard any changes from saving to file. 
Apply: Immediately apply changes to a graph currently being viewed.  

**Note: this will only save appearance within the current file.** 
 
You can change the format of the time axis, the fonts used, as well as the color of the data graph.  
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The General tab controls various display aspects.  Use these to change the appearance of the 
graphed data and the display of gridlines. 

 

 
 
 
 
Use the Fonts tab to change the font, size and style of all text in the data graph window. 
 

 
 

The X-Y Axis tab is used to configure the time format in X axis as well as decimal places, units and 
autoscale option in Y axis. 
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The Lines tab affects the description, color, width and style of the graph line. 

 

 
 
To learn about how to work with the data, visit the Working With The Data section. 
 

 
 

7.2.4. Printing A Graph 
 

Click the icon in the toolbar to quickly print a data graph. 
 

 
 
Note that the Print icon uses the current settings in the printer dialog.  To change settings, or modify 
your printing characteristics, such as printer or page orientation, select Printer Setup or Print from 
the File Menu. 
 

PRINTER SETUP 

 
 
Here, you are able to select the printer, determine the orientation and pick the paper size. You can 
select the Printer Setup option located under the File Menu 
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PRINT 

 
 
By selecting Print from the File Menu options, you may print a document that is currently displayed 
on the SmartButton Reader desktop. This operates the same way as the print ICON, however, it 
allows you to pick a printer and select the number of copies you wish to produce. 
 
To learn about how to work with the data, visit the Working With The Data section. 
 

7.2.5. Zooming Graph 
 
 

To zoom in on a desired portion of a graph, move the mouse pointer to the start (or end) of the 
region of interest.  Press and hold the Left mouse button and drag the mouse to the other end of 
the region of interest.  Release the mouse button and the graph display redraws the selected 
region.  Repeat the process for closer zooms. 

 
Before 
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After 

 
 
Please note that the application does not plot less than three points on a graph. 
To restore the Zoom factor use the Unzoom to Last or Unzoom All options in the Graph option on 
the main menu bar. 

 

 
 
Note: The contents of the Statistics Tab and Data Table Tab change to reflect the data 
graphed. 
To learn about how to work with the data, visit the Working With The Data section. 
 

7.2.6. Adding Temperature Lines To The Graph 
 

To label a desired portion of a graph, move the mouse pointer to the region of interest.  Double click 
the Left mouse button on the region of interest.  Release the mouse button and the graph display 
redraws a temperature line on the selected region.  Repeat the process as needed. 

 
Add Temperature Line 
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To erase the temperature line on a graph, move the mouse pointer to the line and click the Left 
mouse button on the line.  Release the mouse button and the graph displays a box at the center of 
the temperature line.  Once the box is visible,  press the Delete button on your computer: 
 

Select to Delete 

 
 
To learn about how to work with the data, visit the Working With The Data section. 
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8. Menu  
 

Welcome to the Menu Section.  
 

 
 
Referring to the above picture, you will find at the top of the window the menu bar containing items used to 
control the application; File, Communicate, Graph, Options, Window and Help. These are the basic menu 
headings, where you will be able to locate individual functions within the software. To learn more about the role 
of each sub menu feature, please refer to the various Menu Options. 
 

 
 
The icon toolbar is located just below the Menu Bar. The icons are helpful short cuts to perform commonly 
performed tasks. They are there for convenience only. Each short cut icon's function will also be located within 
the Menu Bar headings: 
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8.1. File Menu 
 

Use this menu to Open, Save, or Print.  An illustration of the File Menu is below, along with an 
explanation of the menu's contents: 

 

 

 
 
Open Graph 
To open a previously saved file, select the "Open Graph..." item from the File Menu.  Once the 
application displays the common Open File dialog, use the controls to locate the desired file. 
 
You can also click the  icon in the toolbar to open a file. 

 
Save 
Select either the "Save" or "Save As..." option from the File Menu to save the currently displayed graph to 
disk. 
You can also click the icon in the toolbar to save a file. 
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Save As 

Use this option to save the graph file to a different name or file format.  The application displays the 
common Save As dialog.  Use the fields to enter the file's name, type and desired location. 
 

 
 

 
Close 
Closes the current graph window. 
You can also click the icon in the toolbar to close the active form. 
 

 
 
Print 
Choose this option when you wish to have access to the common printer dialog where you can change 
printer parameters.  
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The form that appears once the Print option has been selected from the pull down menu is: 
 

 
 
To quickly print a data graph just click on the icon on the toolbar. 
 

 
Printer Setup 
Use this option to make permanent changes in your printer driver configurations. 

 

 
Exit 
Ends the current session of the SmartButton Reader and returns to Windows. 
 
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings. 
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8.2. Communicate Menu 
 

Use this menu to specify the serial port to which the SmartButton is connected. 
 

 

 
 

COM1 
Sets the default port to COM1. 
COM2 
Sets the default port to COM2. 
Contact 
Click this option to contact a SmartButton and display its status window. 
 
Please see Contacting a SmartButton for more information. 
 
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings. 
 

 
 

8.3. Graph Menu 
 

Use the Graph menu to change the display of the graph: 
 

 

 
 
Unzoom to Last 
Select this option to restore the display to the most recent zoom factor. 
Unzoom All 
Select this option to restore the graph display to show all points. 
Unzoom All 
Select this option to change the look and feel of your graph display. See Graph Settings for more 
information. 
 
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings.    
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8.4. Options Menu 
 

Use the Options menu to change the default unit of measurement, select a different SmartButton 
interface, or display other options.  An example of the Options menu is below: 
 

 

 
 

Default Units 
Use this option to select the default unit of measurement.  The options are Celsius (ºC), Fahrenheit (ºF) 
and Kelvin. This option is available for set-up of SmartButton variables. 
 
Show Toolbar  
Toggle on and off the display of the icon toolbar at the top of the screen. 
 
Show Status Bar 
Toggle on and off the display of the Status bar at the bottom of the screen. 
 
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings. 
 

 
 

8.5. Window Menu 
 

Use the Window Menu to tile all open windows vertically, horizontally, cascade tile, or select from the 
various open windows. 
 

 

 
 
Tile Horizontal 
Select this option to rearrange all graph windows left to right.  The graph windows are not overlayed and 
are resized to show the window's entire contents. 
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Horizontal View 

 
 
NOTE** In order to retain sufficient X- Axis resolution, ACR recommends that no more than 2 files 

be viewed with this method at a time. 
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Tile Vertical 
Select this option to rearrange all graph windows top to bottom.  The graph windows are not overlayed 
and are resized to show the window's entire contents. 
 

Vertical View 
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Cascade 
Select this option to rearrange all graph windows top to bottom, left to right.  The graph windows overlay 
one another with the title bar exposed.  Click the desired title bar to display the window's contents. The 
bottom of the menu contains a list of all open windows.  To change to another window, click in its title bar, 
or select its name from the list. 
 

Cascade View 

 
 

NOTE** Each graph that is open on the desktop is noted at the bottom of this menu section. If you 
are not using the Tile function, then you will note the graph currently displayed is 
denoted by a checkmark. 

 
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings. 
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8.6. Help Menu 
 

Use the Help Menu to reference the embedded help or more information about this version of the 
SmartButton Reader. 

 

 

 
 

Help Contents 
Select this option to display the contents page of the Help File. 
Help Index 
Select this option to search the Help File for more information. 
ACR Website 
Select this option to link to the ACR Corporate home page (internet connection required). 
About 
Select this option to display the version number and release date of the application, as well as memory 
available for use. 
Help Contents can also be viewed by selecting the Help ICON on the menu bar 
 

    
If you cannot find the Menu item you were seaching for, visit the Menu Section of this 
documentation to look under other Menu headings.    
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9. Still Having Trouble? 
 

 

 
If you are still experiencing difficulty with this software package, please investigate the two sections that we 
have created for the most common difficulties; Frequently Asked Questions and Troubleshooting Questions 
About SmartButton Reader. 
 
In the event that you still cannot overcome your difficulties, feel free to contact our Technical Support 
Department. 
 

9.1. Frequently Asked Questions 
 

Q: Each data logger has a serial number. Is this unique in each case? 
A: Yes. Each logger has its own unique serial number. Files from data loggers will actually reference this 
number. When saving a data file, the name of the file will default to the serial number of the logger that it 
originates from. 
 
Q: What do we mean when we use the term 'IP' rating? 
A: An IP rating refers to the degree of environmental conditions a data logger can be subjected to. For 
example, a data logger that has an IP rating of IP67 is capable of being submerged in water to a depth of 
1 meter for a duration not exceeding 1 hour. In some data logging there may be a regulatory requirement 
that deems it necessary to have an IP rating assigned to your data logger. For more information about IP 
ratings, please contact our Technical Support Department. 
 
Q: What do we mean by 8-bit or 12-bit logger? 
A: 8 bit means one part in 256 and 12 bit means one part in 4096. The output of any sensor connected to 
an ACR data logger is converted to an electrical frequency. This frequency is known as an analog signal. 
This signal is converted inside the data logger to a digital signal (a series of zeros and ones).  
 
The Analog to Digital converter in an 8-bit logger converts the input to a value between 0 to 255. In a 12-
bit logger, the Analog to Digital converter is 12 bit. Hence, the input is converted to a number from 0 to 
4095 (which means higher resolution and therefore higher accuracy).  
 
As an example, if you divide a temperature range of 0°C to 100°C to 256 (8-bit resolution) then each byte 
count will be equal to 100/256=0.39°C. However if you divide the same temperature range to 4096 (12-bit 
resolution), then each byte count will be equal to 100/4096=0.024°C. 
Hence, in this example, one byte count on the 8-bit logger is equal to 0.39°C and on the 12-bit logger it is 
0.024°C.  

 
Q: How do we connect the logger to a computer? Is it an RS-232 connection? 
A: The connection is through the serial port of the computer. It is an RS-232 connection. For more 
information on connecting your logger to a computer please refer to 'Preparing Your Hardware to Use' 
section. 
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Q: What is the fastest and slowest sample rates with SmartButton data loggers?  
A: The fastest sample rate is 1 minute and the slowest one is sample every 255 minutes. 

 
Q: Is the accuracy of thermistor loggers more than thermocouples? What about RTD loggers?  
A: The accuracy of thermistor loggers is more than thermocouples. The accuracy of RTDs is more than 
thermocouples but less than thermistors. 
 
Q: When does the logger start sampling (recording)? 
A: As soon as you clear the logger (or save a set-up to the logger) it starts recording. You can use the 
"Start Delay" feature of the logger and set the logger to start at a particular date and time. The logger will 
continue recording and if the option "Stop when full" is enabled, it will stop recording (when the memory is 
full). Otherwise the logger will continue recording and will overwrite the oldest data (when the memory is 
filled up).  
 
Q: Where is the internal temperature sensor located on the logger? 
A: The internal temperature sensor is located midway inside the ACR SmartButton casing.  
 
In the event that you still cannot overcome your difficulties, feel free to contact our Technical 
Support department. 

 
 

9.2. Troubleshooting Questions About The SmartButton Reader 
 

Connecting the SmartButton 
 
I think that I may be missing components for operating my SmartButton data logger. 
To be sure that you have everything required for operating your ACR SmartButton with SmartButton 
Reader, please refer to the outlined parts required in the 'What Do I Need To Get Started?' section. If you 
discover that you require additional components, please call ACR Technical Support for assistance. 
 
My computer does not have a com port. 
Check the back of your computer for another type of connector. 
In some cases, your computer will not be equipped with a 9 pin communications port. Alternatively, it will 
have either a 25-pin connector or a USB interface. In both cases adapters will be necessary to operate 
your data logger. To learn more about the required adapter for your computer, contact ACR Technical 
Support. 

 
My computer does not detect the SmartButton Data Logger. 
Is your interface cable connected properly? 
While the cable feels like it is securely fixed to the serial port, it may actually be loose. Double check the 
connection and ensure that the cable is screwed into the port and both sides of the wire lead are fully 
plugged into the logger and interface cable. 
Do you have a free com port available to read the SmartButton Data Logger? 
Your modem, mouse, and other devices like these use communications ports, just like the SmartButton 
data logger. Sometimes (especially in laptops) the resources for a free com port are quite limited. In 
cases like this alternatives include, having your other devices operate under alternative com ports (ie 25 
pin or USB terminals) or purchasing a adapter that can convert the available port to a 9-pin configuration. 
 
Alternatively, it is also possible to temporarily disable the conflicting device while operating SmartButton 
with SmartButton Reader. 

 
How come I cannot print the data table in the Tab Menu? 
While you can view the data information in a tabular format, it is not printable within SmartButton Reader. 
To do so you must transfer the file into a spreadsheet readable format and then print from that 
spreadsheet program. To learn more about the procedure, please visit the section "Saving a Graph as a 
Comma Delimited(CSV) Data File" 
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I've done all of the above and I still can't communicate with my Data Logger. 
Please contact Technical Support. They will help you with advanced troubleshooting and diagnosis of your 
equipment. 

 
 Analyzing Logged Data 
 

What is the number in the file name when I am saving my data? 
Each logger has its own unique serial number. Files from data loggers will actually reference this number. 
When saving a data file, the name of the file will default to the serial number of the logger that it originates 
from. This is a default option and if desired, you can change the file name to an alternate name. 
 
I can't find my stored file. Where is it? 
The stored files are stored in the default directory (this is the program file that was chosen during set-up). 
If you would rather store your files in another directory, you can select the directory during backup or by 
selecting Save as under the File menu, you can resave the file under a new directory.  To access these 
files and other directories, outside of SmartButton Reader, please refer to your operating system's help 
manual. 

 
I want to transfer my data into a spreadsheet program. 
The file extension that your data logger stores the information to is SMT. This is a proprietary file 
extension that was chosen by ACR to signify a SmartButton data file. To transfer the data to a 
spreadsheet program, you must first resave the file. During the saving function, you must elect to save 
the file as a CSV format, or comma delimited file. Your speadsheet can then take your stored data and 
transfer it into a data table format. To learn more about the procedure, please visit the section "Saving a 
Graph as a Comma Delimited(CSV) Data File" 
 
In the event that you still cannot overcome your difficulties, feel free to contact our Technical 
Support Department. 
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10. Technical Support 
 

Should you have any questions or problems, please contact our Technical Support Department: 
 

 
 

Voice: 604.591.1128 
Fax: 604.591.2252 

E-mail: customerservice@acrsystems.com 
Web address: www.acrsystems.com 

 
Our mailing address is: 

ACR  Systems  Inc. 
Unit 210, 12960-84th Avenue 

Surrey, BC  V3W 1K7 
Canada 

 
Our customer support representatives are available during normal business hours 6:30am - 4:30pm, Pacific 
Standard Time. 

 

mailto:customerservice@acrsystems.com
http://www.acrsystems.com/
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11. Upgrading My ACR Product 
 

SmartButton and SmartButton Reader are part of a family of many quality products offered at ACR Systems. As 
your data logging needs increase, we will have the product that will best suit those needs. To learn more about 
ACR's product line, order your catalog from our website today; www.acrsystems.com: 
 

 
 
Just visit www.acrsystems.com and select Catalog Order 
 
Check with ACR Systems Customer Support as your needs occur. Chances are that ACR Systems has an 
upgrade program in place that will meet your needs. 

 

http://www.acrsystems.com/
http://www.acrsystems.com/


ACR SmartButton Reader User Manual   
 

 
ACR SmartButton Reader V1.11  Page 64 

 
 
 
 
 
 
 

 
ACR SmartButton Help Manual 

SmartButtons for Smart Solutions 
 

by ACR Systems Inc 
 
 
Section 12:  
Glossary 

 
 
 



ACR SmartButton Reader User Manual   
 

 
ACR SmartButton Reader V1.11  Page 65 

12. Glossary 
 

A 
Active Form: Refers to the windows dialog box that is currently being operated in. 
Accuracy: Refers to the sensor that the logger is drawing its data from. Typically this will be communicated as 
a +/- or % value. 
Autoscale: By selecting this feature, the result is essentially a Y zoom that displays the graph with min/max, 
scaled according to the recorded data's information.   
Analog Signal: The output of a sensor that translates to a voltage frequency (ie: 4 to 20mA). 
Analog to Digital Converter: This component of the data logger takes the sensor information and transforms 
the data into information that can be processed into engineering units.  
 
B 
Backup: To copy data from a data logger to your computer. 
Byte Count: A basic unit of incremental measurement used on a digital computer. 

 
C 
Calibrate: To process and adjust an  instrument so that readings are accurate. 
Com Port: (1) A communications port by which a logger receives the signal it measures. (2) A communications 
port by which a PC (personal computer) interacts with an ACR data logger. 
Comma Delimited: A file that contains text that has been separated by commas.  
Compressed Data: Data that has been compressed to conserve memory. If similar readings are consistently 
recorded rather than repeating the measurement, it is assigned a number that represents the frequency that it 
was measured in. 
 
D 
Data Logger: A device used to take measurements and then store that reading with a corresponding time 
interval.  
Delay Time: A feature that allows a data logger to have it start at a future time/date. 
Desktop Shortcut: A link created on a Windows desktop, which when selected by a pointer, will open the 
program that has been assigned to it. 
Digital Signal: The output of a sensor that translates into a binary code (a series of zeros and ones). 
Dragging: The process of selecting an item on your desktop with your pointer and then while holding your 
pointer button, pulling said item to another location. 
 
E 
Exporting Data: To convert data from its resident file format into a generic form in order to make it readable in 
another program. 
 
F 
FIFO: First in, first out. When a data logger's memory is full and this option is selected, the first reading will drop 
in order to create room for the most recent reading. 
 
I 
IP Rating: An internationally recognized format for gauging the level of elements a casing can be subjected to 
without failure of the product (ie: IP67 refers to a item that can be subjected to water for 1 hour at a depth of 1 
meter without ingression).  
Icon: A link created on a Windows desktop from the EXE program install, that when selected by a pointer, will 
open the program that it has been assigned to. 

 
L 
LPT Port: A parallel communications port for communication with a printer device. 
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M 
Modem: A device that transfers information from the logger via a series of information strings over a 
telecommunications network. 
 
P 
Port: Please refer to Com Port. 
 
R 
RS-232: A protocol by which electronic information is sent and received.  
Resolution:  The number of increments a data logger is capable of dividing a range over. ie: An 8-bit logger is 
capable of 256 increments in any given range. Therefore, in a range of -40°C  to +85°C  we divide the total span 
(85 +40) 125 by 256 (8-bit)= 0.48°C resolution. 
  
S 
Sample Interval: The increment in which the data logger will take a reading. 
Sensor: The device that takes the reading for comprising the data logging sample. 
Status Bar: The area at the bottom of an active Windows program that will  provide a Summary of Status related 
to the program. 
Stop When Full: When this is selected, the data logger will stop recording when its memory has become full. 
 
T 
TRW File: Refers to the standard file format for all ACR data logger files that are created by ACR data loggers. 
Toolbar: Refers to the ICONS located at the top of ACR SmartButton Reader. These ICONS are shortcuts to 
frequently used options within the software. 
Thermistor: A sensor device used to measure temperature. 

 
U 
USB Port: Please refer to Com Port. 
 
Z 
Zooming/ Unzooming data: By holding the left button on your pointing device over an opened ACR graph, one 
can select portions of graphed data to expand. Zooming is done by pulling your pointer over the area you wish to 
expand and then releasing the mouse pointer. To return to the original status we refer to this as ' unzooming'. 
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